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NAME __________________________________________________ DATE ________________________

 

A Line in the Sand

 

A GIS investigation

 

Answer all questions on the student answer sheet handout

 

The ever-changing map of the world reflects the forces of conflict and cooperation among nations 
and peoples of the world. In this GIS Investigation, you will explore one of the first boundary 
changes of the twenty-first century—the creation of a new border between Yemen and Saudi 
Arabia on the Arabian Peninsula. After more than 60 years of conflict, the two nations signed 
the historic boundary agreement in June 2000. Using data provided in the Treaty of Jeddah, 
you will create a map reflecting the treaty’s territory, and analyze underlying physiographic 
and cultural considerations that influenced the location of the boundary.

 

Step 1 Start ArcMap

 

a

 

Double-click the ArcMap icon on your computer’s desktop.

 

b

 

If the ArcMap start-up dialog appears, click 

 

An existing map

 

 and click OK. Then go 
to step 2b. 



 

Regional case study: A Line in the Sand

 

GIS investigation

 

MODULE 5

 

• HUMAN GEOGRAPHY II: POLITICAL GEOGRAPHY

 

292

 

P
H
O
T
O

 

C

 

O
P
Y

 

Step 2 Open the Region5.mxd file

 

a

 

In this exercise, a map document has been created for you. To open it, go to the File 
menu and choose 

 

Open

 

.

 

b

 

Navigate to the module folder (

 

C:\MapWorld9\Mod5

 

) and choose 

 

Region5.mxd

 

 
(or 

 

Region5

 

) from the list.

 

c

 

Click Open.

 

When the map document opens, you will see a shaded relief map of the Middle East 
and northeast Africa. A red outline locates the Arabian Peninsula.

 

d

 

Stretch your ArcMap window so that it fills most of your screen.

Step 3 Identify countries that border the Arabian Peninsula

 

a

 

Click the View menu and choose Bookmarks, Arabian Peninsula. Now the Arabian 
Peninsula fills the view.

 

b

 

Look in the table of contents for a layer called Neighbors - outline. Click the box to the 
left of the layer name to turn it on.

 

c

 

Slide the mouse pointer over the map to display the country names.

 

What countries border the Arabian Peninsula to the north?

 

Step 4 Investigate the physical characteristics of the Arabian Peninsula

 

a

 

The map on your screen is a shaded relief map. It depicts landforms such as mountain 
ranges, valleys, plateaus, and plains.

 

(1) Is any part of the Arabian Peninsula mountainous?

(2) If so, where are the mountains located?

 

b

 

Click the plus sign next to Water in the table of contents to expand this group of 
layers.

 

c

 

Turn on the Bodies of Water and Streams layers. Then display them by checking the 
box next to Water.

 

Most of the streams you see on your map are intermittent, which means that they 
are dry during some parts of the year.

 

(1) Are there any parts of the Arabian Peninsula that do not have any water at all? 
If so, where are these regions?

(2) Do you see any relationship between landforms and the availability of water?



 

GIS investigation

 

Regional case study: A Line in the Sand

 

MODULE 5

 

• HUMAN GEOGRAPHY II: POLITICAL GEOGRAPHY

 

293

 

P
H
O
T
O

 

C

 

O
P
Y

 

d

 

Turn off the Streams layer and observe the distribution of permanent bodies of water 
on the Arabian Peninsula.

 

e

 

Click the Zoom In tool. Click and drag a small box around an area of blue dots.

 

Now you can see the bodies of water more closely.

 

Describe the bodies of water on your answer sheet.

 

f

 

Click the Previous Extent button to return to your view of the entire peninsula.

 

g

 

Turn off the following layers: Water, Arabian Peninsula - outline, Neighbors - outline, 
and Shaded Relief. (You may need to scroll down in the table of contents.)

 

Your map display should look like this:

 

h

 

Collapse the Water group. Expand the Annual Precipitation layer and turn it on.

 

Amounts of rainfall are given in millimeters. Here is a conversion table that 
compares millimeters to inches (25.4 mm. = 1 in.).

 

(1) A desert is defined as a place that gets less than 10 inches of rain per year. How 
many millimeters equal 10 inches?

(2) Based on the amounts of rainfall displayed on the map, do you think there is 
much farming on the Arabian Peninsula? Explain.

(3) Approximately what percentage of the Arabian Peninsula is desert?

 

MM.

 

100 200 300 400 500 600 700

 

IN.

 

3.9 7.9 11.8 15.7 19.7 23.6 27.6
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i

 

Turn off Annual Precipitation. Turn on and expand the Temperature layer group. Turn 
on Temp: Sept. – Nov.

 

Use this conversion table to help you answer the next questions.

 

What is the approximate range of temperatures across the Arabian Peninsula during 
this period?

 

The three layers below Temp: Sept.- Nov. display temperature information for the 
periods December–February, March–May, and June–August.

 

j

 

Turn the temperature layers on and off one at a time to see the change of temperatures 
on the Arabian Peninsula through the four seasons.

 

(1) Which season is the hottest?

(2) What is the approximate range of temperatures across the Arabian Peninsula 
during this period?

 

k

 

Turn off the Temperature group. Scroll up and turn on the Ecozones layer. Expand its 
legend.

 

(1) What relationship do you see between the Arabian Peninsula’s ecozones as 
displayed on this map and its patterns of landforms, precipitation, and 
temperature?

(2) Use your answers from previous questions and turn different layers on and off 
to complete the Physical Characteristics of the Arabian Peninsula table on your 
answer sheet. List three observations for each physical characteristic.

(3) In your opinion, which of the region’s physical characteristics would be 
considered “valuable” in a boundary decision? Explain.

 

Step 5 Investigate the human characteristics of the Arabian Peninsula

 

The population of the Arabian Peninsula is approximately 45 million. The majority 
of this population lives in Saudi Arabia (22 million) and Yemen (17.5 million). The 
remaining 5.5 million can be found in Oman, the United Arab Emirates, and Qatar.

 

a

 

Turn off Ecozones. Turn on the Arabian Peninsula - names layer. This layer locates the 
countries by name, but does not show their borders. You will explore the borders of 
these countries in the second part of the investigation.

 

b

 

Turn on the Major Cities and Agriculture layers. Expand the Agriculture legend to see 
a list of the types of agricultural activity on the Arabian Peninsula.

 

ºC

 

5º 10º 15º 20º 25º 30º 35º 40º

 

ºF

 

41º 50º 59º 68º 77º 87º 95º 104º
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(1) What is the principal agricultural activity on the peninsula?

(2) Based on what you now know about the physical characteristics of the region, 
why do you think the agricultural activity is so limited?

 

c

 

Turn on and expand the Population Density layer. The human population around 
major cities and throughout the Arabian Peninsula is displayed as number of people 
per square kilometer.

 

(1) How does Yemen compare to the rest of the Arabian Peninsula in population 
density?

(2) Describe the overall population density of the Arabian Peninsula.

d Turn off Population Density. Make sure Agriculture is still turned on.

e Turn on Water, then expand it and turn on Springs. Turn off Bodies of Water.

The Springs layer shows the location of springs and water holes.

f Look at the map.

(1) On your answer sheet, speculate about the ways water is most commonly and 
frequently used at these springs and water holes.

(2) Use your answers from previous step 5 questions and analysis of the maps to 
complete the table on your answer sheet. List three observations for each human 
characteristic.

(3) If an international boundary were to be drawn across some part of the Arabian 
Peninsula, how would these characteristics influence the perception of certain 
regions as being more valuable than others?

Step 6 Locate and describe the Empty Quarter

a Turn off Springs and turn on Roads. Expand the Roads legend.

Take note of the large area with practically no roads in the south-central part of the 
peninsula. This region is called the Rub´ al-Khali and is also known as the Empty 
Quarter. The Empty Quarter is important to this lesson because most Saudi Arabian 
borders with its southern neighbors cross this region.

b Turn the following layers on and off so you can observe the characteristics of the 
Empty Quarter: Streams, Population Density, Agriculture, Ecozones, Temperature, and 
Annual Precipitation.

(1) Complete the table on your answer sheet. List three observations in each column.

(2) What difficulties would an area like this present if an international boundary 
must cross it?

c Right-click the Middle East data frame in the table of contents and choose Collapse All 
Layers.
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d Right-click Middle East again and choose Turn All Layers Off. Then turn the following 
layers back on: Major Cities, Arabian Peninsula - names, and Basemap.

e Ask your teacher for instructions on where to save this map document and on how 
to rename it. Record the map document’s new name and where you saved it on your 
answer sheet.

Follow the steps below to exit ArcMap if you will be doing steps 7–12 at a later 
time. If you will be continuing to work now, skip to step 7b.

f From the File menu, click Exit.

Step 7 Explore Saudi Arabia’s southern boundaries

a Start ArcMap. Navigate to the folder where you renamed and saved Region5. Open 
the map document.

b Right-click the Saudi Arabia Southern Boundaries data frame and click Activate. 
Expand the data frame legend.

This map looks very similar to the Middle East map. 

c Turn on the 20th Century Boundary layer.

This layer reflects the boundary agreements Saudi Arabia made with most of its 
southern neighbors at the end of the twentieth century.

(1) Are the boundaries what you expected them to be?

(2) Which boundary remained unsettled?
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According to international boundary expert Richard Schofield, this boundary was 
“the last missing fence in the desert.” The only part of the boundary that was mutu-
ally agreed upon was the western area adjacent to the Red Sea. Over the years, the 
boundary has shifted. Now you will add layers that reflect some of the major bound-
ary changes.

d Click the Add Data button. Navigate to the module 5 data folder and look in the 
LayerFiles folder (C:\MapWorld9\Mod5\Data\LayerFiles). Hold down the Shift 
key and click once on each of the following file names: Yemen1.lyr, Yemen2.lyr, 
and Yemen3.lyr. Click Add.

e Turn off Yemen2 and Yemen3 for the moment and look at the red line of Yemen 1.

This line represents the boundary between Yemen and Saudi Arabia established by 
the Treaty of Ta’if in 1934. It is the only part of the boundary that both countries 
recognized at the turn of the twenty-first century.

f Turn on Yemen2.

The green line of Yemen2 represents the Saudi–Yemeni border recognized by Yemen 
at the end of the century. It is based on lines established when Yemen (then the 
Aden Protectorate) was under British control in the early twentieth century. Most 
maps used these lines to delineate the extent of Yemen prior to 2000. This bound-
ary was not recognized by Saudi Arabia.

g Turn on Yemen3.

This purple line represents the Saudi–Yemeni border claimed by Saudi Arabia at 
the end of the twentieth century. It is based on lines established by the Saudis in 
the mid-1930s. This line was still being used on Saudi Arabian maps to represent 
the boundary in the 1990s.

h Click the Zoom In tool. On your map, click the label Yemen. Now the map is centered 
on the country of Yemen.

i Click the Fixed Zoom In button two or three times until the country of Yemen fills the 
view.

What does the area between the green and purple lines represent?

j Turn on Agriculture and expand its legend.

What is the principal economic activity of the regions in dispute?
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k Turn off Agriculture and turn on and expand Population Density.

Describe the population distribution in the disputed territory.

If you were asked to settle the disputed boundary between Saudi Arabia and Yemen, 
where would you draw the line? In this next step, you will draw a proposed bound-
ary line between Saudi Arabia and Yemen, using the Draw Line tool.

l Make sure the Draw toolbar is displayed. If you don’t see it, right-click in the gray 
space to the right of the Help menu to display the toolbar list and click Draw. A good 
place to dock the Draw toolbar is at the bottom of the ArcMap window.

m In the Draw toolbar, click the down arrow next to the New Rectangle tool and choose 
the New Line tool.

n On your map, click the eastern end point of the red boundary line. (This is the bound-
ary that both countries agree on.) Proceed eastward (to your right) and click a proposed 
boundary line. Double-click when you get to the end of your boundary. Now you have 
an additional black line that extends from the red line to Oman.

o Make sure the Select Elements tool is now active. Click anywhere on the map away 
from the line you drew to make the blue selection box disappear.

In the next step, you will view the new boundary actually agreed upon by Saudi 
Arabia and Yemen in 2000.

Step 8 Draw the Saudi–Yemeni boundary

In June of 2000, Saudi Arabia and Yemen signed the Treaty of Jeddah, which settled 
their 65-year-long boundary dispute. The boundary agreement had three parts. The 
first part of the treaty reaffirmed agreement on the 1934 Ta’if line (Yemen1.shp). The 
agreement did say, however, that the line would be amended in any place where it 
cuts through villages.

a Click the Zoom In tool. Zoom to the area of the Ta’if line (red line) by dragging a box 
around it.
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b Click the Add Data button. Navigate to the module 5 Data folder and look in the 
LayerFiles folder (C:\MapWorld9\Mod5\Data\LayerFiles). Select Cities and 
Towns.lyr. Click Add.

(1) Does the red line go through any cities or towns? (Hint: You may need to zoom 
in again to answer the question.) If yes, approximately how many does the 
boundary pass through?

(2) How would you decide which side of the town to put the boundary on? 
Remember, this decision would determine whether the residents of that village 
would be citizens of Saudi Arabia or Yemen.

The second part of the Treaty of Jeddah determined the new boundary from the end 
of the red line to the border with Oman, 500 miles to the east. The treaty did not 
actually draw the line, but gave its starting and ending points and points in between 
as latitude/longitude grid coordinates. You will now plot these points on your map to 
locate the new boundary line.

c Turn off Cities and Towns and Population Density.

d Click the View menu, point to Bookmarks, and choose Yemen to zoom out to the 
entire country.

You will need your own layer for holding the data you will plot. You will export a 
copy of the BoundaryTemplate layer, which has no features, for this purpose.

e Right-click the BoundaryTemplate layer. Point to Data, then click Export Data.

f Click the Browse button in the Export Data dialog. Ask your teacher what type of file 
you should save and where you should save it. If you will be saving a feature class, 
choose Personal Geodatabase feature classes from the Save as type drop-down list 
and navigate to the MiddleEast geodatabase. Otherwise, choose Shapefile and navi-
gate to the location your teacher directed you.
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g Name the file ABC_Yemen4 where ABC are your initials. Click Save, and then click 
OK in the Export Data dialog.

h Click Yes to add the exported data to the map. Check the box to turn on ABC_Yemen4.

i Right-click the BoundaryTemplate layer and click Remove to remove it from the map.

You will use tools on the Editor toolbar to plot the latitude and longitude coordinates 
for the new Saudi–Yemeni boundary.

j Click the Editor Toolbar button to turn on the Editor toolbar. Dock the toolbar above 
the map.

k Click the Editor menu on the Editor toolbar and choose Start Editing. Click the source 
for your ABC_Yemen4 layer in the dialog that appears and click OK.

l On the Editor toolbar make sure the Task is set to Create New Feature. Make sure the 
Target is your layer: ABC_Yemen4.
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m Click the Sketch Tool on the Editor toolbar.

n Right-click anywhere in the map and choose Absolute X,Y.

The first point you will enter is 52 degrees longitude, 19 degrees latitude.

o Type 52 for X. Press the Tab key and type 19 for Y. Press the Enter key.

You see a red square called a vertex appear at the border with Oman. Your cursor 
is attached to the vertex with an elastic line. As you move your mouse around the 
map without clicking, the line changes. The elastic line tells you that the new line 
feature you are creating is not yet finished.

p To enter the remaining longitude and latitude points determined in 2000, consult the 
table below (points 2–17). For each point, you must right-click in the map and choose 
Absolute X,Y and then enter the coordinates from the table. Enter all the points now.

Hint: If you make a mistake entering a point, click the Undo button to 
delete it. Then enter the coordinates for that point again. If you want 
to delete all the points you entered and start over, double-click to 
complete the polygon and then press the Delete key. Enter the points 
again beginning with point number 1.

q When you are satisfied that you have entered all of the points correctly, right-click 
anywhere in the map and choose Finish Sketch. The completed line is highlighted 
in blue.

r Click the Editor menu on the Editor toolbar and choose Save Edits. 

Does the new line seem to favor Yemen or Saudi Arabia? Explain.

Point Longitude Latitude Point Longitude Latitude

1 52.00 19.00 10 46.37 17.23

2 50.78 18.78 11 46.10 17.25

3 49.12 18.61 12 45.40 17.33

4 48.18 18.17 13 45.22 17.43

5 47.60 17.45 14 44.65 17.43

6 47.47 17.12 15 44.57 17.40

7 47.18 16.95 16 44.47 17.43

8 47.00 16.95 17 44.37 17.43

9 46.75 17.28
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Step 9 Enter the maritime part of the boundary

The third and final part of the Treaty of Jeddah clarified the maritime boundary 
between Saudi Arabia and Yemen. A maritime boundary defines the offshore limits 
of a country. It too was defined by a series of latitude/longitude grid coordinates.

a Follow the procedure outlined in steps 8n–8q to map the maritime boundary between 
Saudi Arabia and Yemen.

b When you have finished the sketch, click the Editor menu and choose Stop Editing. 
Click Yes to save your edits.

c Click the Editor Toolbar button to dismiss the toolbar.

d Click the Fixed Zoom Out button twice. Look at your map.

What body of water does the maritime boundary traverse?

Because ArcMap randomly selects a color for a new layer, you need to change it. 
You will also give the layer a more descriptive name.

e Click the name of the ABC_Yemen4 layer two times slowly and change the name to 
2000 Boundary. Right-click the line symbol and choose a dark blue color from the 
color picker.

How does the actual boundary established by the Treaty of Jeddah compare with the 
boundary you drew earlier (black line)?

f Turn on Agriculture and Population Density as needed to answer the following 
question.

Write three observations about the boundary line created by the Treaty of Jeddah.

g Save your map document.

Step 10 Define the pastoral area

The Treaty of Jeddah included additional provisions about the new Saudi–Yemeni 
boundary. One of these was the creation of a “pastoral area” on either side of the 
boundary. Shepherds from either Yemen or Saudi Arabia are allowed to use the 
pastoral area and water sources on both sides of the border according to tribal tra-
ditions. The treaty declared that the pastoral area extends 20 kilometers on either 
side of the border. In this step, you will map the 20-kilometer pastoral area.

a How many miles is 20 kilometers? (Hint: 1 kilometer = .6214 miles)

b Click the Selection menu and click Set Selectable Layers.

Point Longitude Latitude

1 42.77 16.40

2 42.15 16.40

3 41.78 16.29
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c Click the Clear All button in the Set Selectable layers dialog to uncheck all of the layers. 
Then click the box for 2000 Boundary to make it the only layer that is checked on. 
Click Close.

d Click the Select Features tool in the Tools toolbar.

e Click the blue 2000 Boundary line that crosses the land. It becomes highlighted blue 
on the map.

f Click the Show/Hide ArcToolbox Window button to open the ArcToolbox window.

ArcToolbox is where you can access many ArcGIS tools that work on your data. You 
will use the Buffer tool to draw the 20-kilometer zone around the boundary line.

g Expand the Analysis Tools toolbox and then expand the Proximity toolbox. Double-
click the Buffer tool to open the Buffer dialog.

h Click the down-arrow to show the Input Features drop-down list and choose 2000 
Boundary.

i The default Output Feature Class will be the same location and type (geodatabase 
feature class or shapefile) as the 2000 Boundary layer (ABC_Yemen4). Keep the default 
unless your teacher asks you to change it.

j For Distance, choose Kilometers from the Linear unit drop-down list, and then type 20 
in the box on the left as the buffer distance.

k Click OK. After the buffer is completed, close the Buffer window if necessary. Close 
the ArcToolbox window by clicking the small ✕  in the upper right corner.

l Drag the ABC_Yemen4_Buffer layer below the 2000 Boundary layer in the table of 
contents.

m Right-click the 2000 Boundary layer, point to Selection, and click Clear Selected 
Features to clear the selection.

(1) In which part of the Saudi–Yemeni border will the pastoral area be most 
significant? Explain.

(2) Why do you think the Treaty of Jeddah created a pastoral area?
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Step 11 Create a map of the Arabian Peninsula

Before you print a map of the Arabian Peninsula, you need to clean up the map.

a Click the Select Elements button. Click the boundary line you first drew (it’s black and 
doesn’t have the buffer around it). A dashed box appears to show the line is selected. 
Press the Delete key. Your line disappears from the map.

b Go to the Arabian Peninsula bookmark.

c Decide what layers you want to display on your map. Include the following layers:

• Major Cities
• 2000 Boundary
• Yemen1
• 20th Century Boundary
• Arabian Peninsula - names
• Arabian Peninsula - area
• Neighbors - countries

d From the File menu, click Page and Print Setup. Follow your teacher’s instructions to 
select the correct printer name. Be sure to check the Use Printer Paper Settings box 
and the Scale Map Elements proportionally to changes in Page Size box. In the Paper 
section, choose Landscape paper orientation. Click OK.

e From the File menu, click Print. Click OK to print a copy of your map.

Step 12 Exit ArcMap

In this exercise, you explored physical and human characteristics of the Arabian 
Peninsula. After analyzing this data, you explored boundary issues in this region 
and plotted the new Yemeni–Saudi boundary established by the 2000 Treaty of 
Jeddah.

a Save your map document.

b From the File menu, click Exit. When asked if you want to save your changes, click No.


